
Cossacks - The Art of War 
Scenario Editor 

Review 
Striking stories and engrossing adventures of glorious musketeers catch the attention of any man with the 
heart of a warrior, the way fairytales about real heroes overwhelmed our minds in childhood. Now you 
stand a real chance of creating your own fairytale. Excellent graphics will boost your story to the 
Hollywood heights. Taking advantage of the mighty Cossacks engine and using your imagination, you can 
make your dreams come true. That’s what this scenario editor has been created for.  
Design your own universe with its very own laws and give other people a possibility to plunge into the 
amazing world of great battles of the Renaissance period in Europe, the cultural and economic centre of 
the world's civilizations. 
The scenario editor has been designed for single player mission creation. The scenario editor window 
consists of the main menu, trigger list and trigger list controlling buttons. 

Creating, Opening and Editing Scenarios 
A new scenario is created based on a previously designed map, i.e. first you must create a map in the 
map editor. Once this is done, click on "New …" in the "File" menu and select the map in the file selection 
dialogue. 
Click on "Save" in the "File" menu to save the game. After that, a new mission will be added to the 
dialogue window of the Cossacks single player mission selection. By defaults, the name of the mission will 
coincide with the name of the map.    
Use the "Open" function in the "File" menu to open a user-created mission for editing. 

Link with Map Editor and Launch Mission 
In order to link any changes to the map with an open scenario, you should click on the "Edit Map" option 
in the "Scenario" menu. When you are through with making changes, it is necessary that you save the 
map using the same name! 
An open scenario can be launched by clicking on "Start Mission" in the "Scenario" menu. 

Triggers 
A trigger is the main logic unit for scenario building. 

Getting Familiar with Triggers 
In any mission, the player is supposed to accomplish certain tasks. Accomplishing these provokes 
responsive computer actions. A trigger is the computer's response to a player's action. For example, the 
player is supposed to kill the enemy general in order to win. The general's death is a condition the trigger 
responds to, and conferring victory upon the player is the computer's response. An event leading to the 
trigger is called a "trigger activation condition". The trigger's response is called a "responsive action". 
At the beginning of the mission, all triggers are active and will snap into action as soon as the condition is 
performed. Having worked once, the trigger is deactivated and will never work again. To force it to 
operate once again, use the "Activate current trigger" option. 
 

Condition 
A condition will be met or not, as the case may be. Here's an example of a condition: "Amount of food 
owned by red player is more than 1000". If the red player has more than 1000 units of food, this condition 
is met. 
A condition may be either simple as in the previous example, or complex, i.e. a combination of simple 
conditions. Complex conditions are considered met if every simple condition contained within them is met. 
If a condition is met, the scenario will perform commands from the action section and this trigger will 
become inactive. 

Action 
Commands in the action block are performed consecutively, one by one. Thus, in certain cases, any 
changes in the array of commands may lead to undesirable consequences, frequently quite deplorable 
ones. To simplify non-linear plot creation, there is an "Inserted condition block" action. 

Inserted Condition 
The action "Inserted condition block" is used to heed some secondary parameter inside the trigger (for 
example, mission difficulty level). This action consists of three sections, i.e. an "If" section similar to the 
trigger condition section, and two action sections. The "Then" section contains commands fulfilled when 
the "If" condition has been met. The "Else" section contains commands fulfilled when the "If" condition is 
not met. 
There are two ways of provoking different computer reactions for difficulty levels. The first is to create a 
separate trigger for each difficulty level. Trigger condition sections will differ only in one simple condition, 



the "difficulty level". Another way is to use only one trigger with its action section containing the "Inserted 
condition block" actions for each difficulty level. So, it's up to you which way to go. 

Manipulating triggers 
The trigger list is presented by the TreeView element, the element displaying the tree of folders in the 
Windows Explorer. 
Commands for manipulating triggers are located either to the right of the trigger list or in the "Edit" menu. 
Click on "New Trigger" to add a new trigger. Every trigger is given a name that can be changed by 
selecting the trigger and clicking on "Change …". If necessary, you can duplicate a trigger by selecting the 
"Duplicate" command. Select a trigger and use the "Delete" command to delete it. The order of triggers 
can be changed with the help of the "Up" and "Down" commands. 
Each trigger consists of two sections, i.e. "Condition" and "Action". To make these sections visible, click on 
the plus sign to the left of trigger name. 

"Condition" Section 
This section contains the list of simple conditions for a given trigger. Their order is of no importance. The 
trigger will work only if every simple condition is met. By default, this section contains the simple 
condition "Always". This means the trigger doesn't require a player to perform any actions and will snap 
into action as soon as it is activated. 
To add a new condition, use the "Add Condition" command. A condition will be added to the right trigger if 
the trigger list pointer is placed either on the name of the trigger, on the name of a section - i.e. 
"Condition" or "Action" - or on the name of any simple condition or action of these sections. 
Each condition constitutes a statement. For example, "Amount of gold possessed by red player is more 
than 1000". 
The "Add Condition" command brings up a dialogue that allows you to select a condition. In the upper part 
of the window there is a set of all conditions split into groups. In the lower part is a condition you can set 
parameters for. Changeable parameters are displayed in white and underlined. By default, every 
parameter is not set, but presented by a key word. For example, the key word for the amount of 
resources is quantity, and resource is the key word for naming a resource. As soon as you have set all 
parameters, the "OK" button is activated. Press this button to finally add a condition to the "Condition" 
section. 
Simple conditions can also be changed, deleted, and duplicated in the current section. In addition to that, 
you can change the order with commands analogous to those for the triggers. 

"Action" Section 
This section contains the list of the computer's retaliatory actions. If the trigger snaps into work and the 
"Action" section is empty, no computer response will be generated. 
A simple action can be added using the "Add Action" command. When working with actions, you act in the 
same way as with conditions. But the order of the retaliatory actions may now affect the response. Actions 
are performed one by one, starting at the top. 
An example of an incorrect trigger location: The "Attack enemy with selected units" command implies that 
units have already been selected. Therefore, the "Select Units" action must be performed beforehand. 

"Inserted condition block" Action 
This action, like any other, includes the name of the action. It differs in that it has three more sections. 
The "If" section is similar to the "Condition" trigger section. Two other sections - "Then" and "Else" - 
contain actions. 
To add a condition to the "If" section, set the cursor on a name or on one of this section's conditions and 
use the "Add Condition" command. Actions are added into the section where the cursor is. As for the rest, 
these sections are totally analogous to the "Condition" and "Action" sections. 

Description of Parameters for Conditions and Actions 
Click on this to change the value of either a condition, or an action parameter. This brings up a dialogue 
window asking you to select the value of this parameter. This section contains a description of all 
parameters possible and uses dialogue windows to set them. 
Mostly, the value of a parameter is an element of some list. Sometimes the name of the element can be 
changed with the help of the "Rename …" button. To acquire a text field consisting of several paragraphs, 
press "Ctrl+Enter". 

Flags and Timers 
Flag can be either on or off. A flag's status is defined by the mission maker. By default, all flags are on! 
Timers are used if an action is to be performed with a time delay. First, set the timer using the "Set 
Timer" action. Before the time you have set elapses or if the timer has not been set, it is considered "not 
rung". When the time elapses, the program considers the timer to have "rung". Time is specified in inner 
conventional Cossacks engine ticks. On more powerful machines, the timer will ring sooner than on slower 
computers! 
There are 256 flags and timers available for users. A dialogue window for flag and timer selection lists all 
changeable names. 



Time 
This parameter defines the time in Cossacks. Each timer tick is proportional to animation ticks or FPS. 
Under slow play mode, a timer tick corresponds to one frame. For example, if your computer has FPS=25, 
that means the Cossacks engine will display 25 frames and 25 inner ticks will elapse. At fast speed, every 
animation frame is equal to two inner ticks. 

Groups and Zones 
These are the most frequently used parameters when writing missions. 
Zone and group creation can only be performed in the map editor if you have previously activated "Scroll 
Lock" on your keyboard! 
A group can include both units and buildings. Grouped units and buildings are framed yellow. In the upper 
middle part of the framework, the name of the group is displayed. 
A zone is a map area limited by a yellow circle of a certain radius. In the centre of the zone is a sign 
stating the zone's name. 
Units of a certain group may trespass a map area belonging to some zone. If so, at this very moment a 
trigger will be activated and a responsive computer action will be performed. 
To create a group, select units and buildings to be included in the group and, using the "Create Mission 
Group" tool or pressing "Ctrl+Enter", enter a group name and press "OK". 
It is impossible to add new units to a group with one command. To do this, you need to delete an old 
group and create a new one bearing the same name, but with new units this time. To delete a group, 
place mouse cursor inside the yellow frame. Its colour should change to white. Press the "Delete" key. 
Using the "Create new group of units" action, you can generate dynamic groups of units while running the 
scenario. 
Dynamic and editor-created groups may contain units belonging to different players! One unit may belong 
to different groups! 
To place a new zone you need to press "Ctrl+Enter" or use the "Create Mission Zone" tool located in the 
tool panel. Note that none of the buildings or units must be selected at this moment. Once this operation 
has been completed, enter a zone name into the text field and press the "OK" button. On the tip of the 
mouse pointer a sign will appear stating the zone name. Select an area on the map to specify the zone's 
centre and press the left mouse button. By default, the zone radius is set to zero. To change the radius, 
take the mouse pointer to the bottom of the zone name sign and press the left mouse button. Without 
releasing the button, move the pointer away from the zone's centre. By releasing the button, you will set 
the zone radius. In order to change the radius later on, you should place the mouse cursor on the zone's 
circumference. To change a zone's location, grab the name sign at the bottom and move the zone. You 
can delete a zone by pressing the "Delete" key while moving the zone. 
Be careful when deleting groups and zones. In the map editor there is no undo command! If there are 
some units selected and you have met the conditions for deleting some zone and group at the same time, 
then pressing the "Delete" key for the first time will delete the group, and pressing it again will delete the 
zone. Pressing it once more will delete the units selected. 
Dialogue windows of group and zone settings present lists of names which are not to be changed. The 
group list also includes dynamic groups, with names which can be changed. 

Dynamic Groups 
The scenario editor saves dynamic groups automatically. By default, it contains no units. There are 64 
dynamic groups available for users. While playing a mission, i.e. while a scenario is being played, the units 
comprised in these groups may change. For example, newly selected units can be added to existing units 
of a dynamic group with the "Save player's selected units to dynamic group" action. With the help of the 
"Create new group of units" action, you can have new units show up immediately on the map during the 
scenario performance. 
Standard names of dynamic groups, i.e. "GroupXX" - where XX is a number between 0 and 63 - can be 
changed in the dialogue window for dynamic group selection only. The dialogue window for group 
selection contains group names and groups created in the map editor and their names cannot be changed. 
You can't rename groups in this window. 

Players 
Before the game starts, every player is assigned one of the eight possible colours. The maximum number 
of players is therefore eight. In single player missions, a player will always be red! The other colours are 
available for computer rivals. 
Apart from the colour, each player is given a name. Before starting any mission, the player sets a name 
for himself. The computer players require a name to be assigned to them. By default, player names 
coincide with their colours. But they can be changed if you like. 
If there is no unit or building of some colour, then the name of this player is not displayed in the 
information window. 

Objectives 
While playing the mission, pressing the "F1" key opens the "Mission Objectives" window, where the 
current objectives are shown. 



An objective is a certain text describing the assignment given to a player, or any other information (for 
example defeat conditions). The objectives can be displayed as not accomplished, or accomplished (the 
same text, but crossed out or hidden). 

Messages 
You can pass information to a player by means of the "Display Message" action. This action will open a 
dialogue window with text and a picture inside, while running the scenario. This will halt the game, so that 
it won't continue until the player hits the "OK" button. To put a question, you also need to set a message 
parameter in one of the conditions: "Affirmative answer to question" or "Negative answer to question". 

Difficulty 
The level of difficulty is set by the player before the mission starts. For computer players, the level of 
difficulty is set when launching the artificial intelligence. The parameter range includes easy, normal, hard 
and very hard options. 

Relations 
Relations between players can be either friendly or hostile. Units of friendly players do not attack each 
other. Such players form an alliance. The dialogue window contains 8 rectangles of different colours 
symbolizing players. If all the rectangles are placed vertically, then all the players are enemies. To form 
an alliance of two players, you need to mouse-grab one of the rectangles and drag it onto the same 
horizontal line with the other. Players on the same horizontal line will become friends. You can make all 
the players enemies by selecting the "All Enemies" button, and friends with the "All Friends" option. 

Resources 
There are 6 resources in Cossacks: wood, gold, stone, food, coal and iron.  

Unit Types 
Unit type parameters include parameters for both units and buildings. All units are split in groups. Every 
nation has its own set of units and buildings. In the Originals group there are units belonging to the 
nations. In the Mercenaries group are all mercenary units. 

Upgrades 
The list contains all the upgrades, divided into groups according to nations and units they affect and 
places they are carried out in.  

Formations 
This parameter sets positional relationship of units. To the left there is a list with names of formations. To 
the right is a schematic drawing. Yellow crosses denote basic units, while commanders are shown with red 
ones (e.g. the officer and drummer). 

Quantity 
Numerical value. 

Relation 
Relation is used in conditions which require quantitative parameters. For example, "Number of units in 
group Group0 is 0". 

Radius 
Used in the "Open map area" action, this defines the size of the radius for the zone to lift the fog of war 
in. The value of 1 will reveal an area covering one pikeman's range of view. 

Direction 
This parameter sets the direction units will look into. The value of this parameter should be a numerical 
one, ranging from 0 to 255. 0 means that units will be turned to the right. Increasing the value will turn 
units clockwise. For instance, if you set 127, your units will face to the left. 

Number 
Identifies the number of the map area in actions "Open map area" and "Turn open map area off". 

Changing/Adding 
Applied when you want several groups selected at the same time. Firstly, you need to select one group 
and then select another one. The first action changes the previous selection, while the second adds the 
new group to your previous selection. 

Condition Description 
To make it more convenient, all conditions are split into subgroups. The name of the condition is put in 
bold letters. The condition's name with the possibility to change parameters is enclosed in brackets. Every 
parameter is enclosed in inverted commas. 

Basic 
This subgroup contains conditions not included in other subgroups. 



Number of ticks after the game beginning. (number of ticks after game beginning "ratio" 
"time"). There's an inner timer which is launched at the beginning of every mission and stands for the 
amount of inner conventional ticks after the game has started. If you want the trigger to be activated a 
certain period of time after the game starts, use this condition. 
Difficulty level. (difficulty level of player "name" "ratio" "difficulty"). The red player is human. 
Before starting the game, a player selects a difficulty level. By default, the same difficulty level is set for 
all other players. The difficulty level will change for all players but the red one if the Give control to 
computer player action is performed. 
Quantity of resource owned by player. (quantity of "resource" owned by player "name" "ratio" 
"number"). Each player can accumulate six types of resources. To change the quantity of resources, 
there are the actions of the "Resources" subgroup at hand. 

Number of Units 
This subgroup includes conditions to verify the number of living and killed units of a player in a zone or 
group. 
Player has already been vanquished. (player "name" has already been vanquished). As soon as a 
player has no peasants and military units left, this condition is met. 
Player has not been vanquished yet. ( player "name" has not been vanquished yet). This 
condition is fulfilled as long as the condition "Player has already been vanquished" is not met. 
Number of player units group. (number of units of player "name1" in group "name2" "ratio" 
"number"). This condition checks on the number of living units possessed by a player specified and 
belonging to a particular group. As soon as the number equals a specified number, the condition is met. 
Number of group units in zone. (number of units of group "name1" in zone "name2" "ratio" 
"number"). This condition checks on the number of living units of a group specified and located in the 
indicated zone. 
Number of player’s units in zone. (number of units of player "name1" in zone "name2" "ratio" 
"number"). This condition verifies the number of living units of a certain colour located in the zone 
specified. 
Number of units of a certain type in zone by player. (Number of "type" units in zone "name1" 
by player "name2" "ratio" "quantity"). This condition verifies the number of living units of a certain 
colour located in the zone specified. Remember, only units of a specified type are counted. For example 
Bavarian 17th century pikemen. 
Number of units in group. (number of units in group "name" "ratio" "number"). This condition 
verifies the number of living units which belong to a specified group. 
Number of units of a certain type by player. (number of "type" units by player "name"). Verifies 
the number of living units of a type indicated possessed by a specified player. 
Number of deceased units of a certain type by player. (number of deceased "type" units by 
player "name" "ratio" "quantity"). Verifies the number of dead units of a type specified once 
possessed by a player indicated. 
Number of killings by group units. (number of killings done by units of group "name" "ratio" 
"number"). For every killing a unit receives one point. This condition verifies the ultimate amount of 
killings by units of a specified group. 

Flags and Timers 
This subgroup includes conditions for checking on flags and timers. 
Flag is on. (flag "name" is on). This condition is met if the parameter-specified flag is on. 
Flag is off. (flag "name" is off). This condition is met if the parameter-specified flag is off. 
Timer has snapped into action. (timer "name" has snapped into action). The condition is met if a 
timer specified was launched and the time set has elapsed. 
Timer has not snapped into action yet. (timer "name" has not snapped into action yet). The 
timer has not been launched yet or the time set has not elapsed yet. 
Number of ticks left before timer rings. (number of ticks left before timer "name" snaps into 
action "ratio" "integer"). This condition is met if a certain number of ticks is left before the timer will be 
activated. 

Questions 
This section contains conditions a player can be asked a question with. These conditions may be added to 
the condition section for the "Inserted condition block" action only. 
Affirmative answer to question. (affirmative answer to "question"). The answer can be "yes" or 
"no" only. If a player answers "yes", the condition has been met. The parameter "question" is described in 
the section "Description of Parameters for Conditions and Actions" section. 
Negative answer to question. (negative answer to "question"). In order for this condition to be 
met, a player must answer "no". 

Buildings 
For conditions of this subgroup, we recommended using a group of one building which the verification is 
carried out for. 



Buildings produce units. (buildings of group "name" produce units). If a building belonging to a 
group specified is producing a unit, this condition is met. 
Buildings do not produce units. (buildings of group "name" do not produce units). This condition 
is met if a building of a group specified is not producing units at the moment. 
Group buildings have already been constructed. (buildings belonging to group "name" have 
already been constructed). Verifies whether a building of a group specified is finished. 
Group buildings have not been constructed yet. (buildings of group "name" have not been built 
yet). This condition won't be met unless a building is finished. 

Upgrades 
The following conditions verify whether a player has launched or accomplished a certain upgrade. 
Player has already launched upgrade. (player "name1" has already launched upgrade 
"name2"). 
Upgrade has not been launched by player yet. (player "name1" has not launched upgrade 
"name2" yet). 
Upgrade has already been accomplished by player. (player "name1" has already accomplished 
upgrade "name2"). 
Upgrade has not been completed by player yet. (player "name1" has not completed upgrade 
"name2" yet). 

Transport 
This subgroup verifies the condition of the ferry. 
Number of passengers in transport. (number of passengers in transport of group "name1" by 
player "name2" "ratio" "quantity"). This condition is met if the transport of a group specified has a 
specified number of units on board. 
Transport has landed. (transport from group "name1" and belonging to  
player "name2" has landed). This condition will be met if there is a landed ferry within a group 
specified. The condition is verified for a player indicated. 
Transport has not landed yet. (transport from group "name1" and belonging to player "name2" 
has not landed yet). This condition is met if none of the ferries of a group specified and belonging to a 
specified player has been moored. 
 

Action Description 
Actions are split into groups too: 

Basic 
The subgroup actions were described in detail in the "Trigger" section. 
Inserted condition block. (inserted condition block). Verifies a certain condition within the section 
and, depending on its performance or non-performance, runs a corresponding action. 
Activate current trigger. (activate current trigger). Due to this action, an activated trigger will 
remain active. 

Flags and Timers 
This subgroup contains actions for changing the condition of flags and timers. 
Set timer. (set timer "name" for "integer" ticks). Indicating the time by ticks, this action sets the 
timer. With every inner tick, the program takes away one unit from the amount of time indicated. As soon 
as it equals zero, the condition "Timer has snapped into action" will be met. 
Turn flag on. (turn flag "name" on). Switches an indicated flag on. 
Turn flag off. (turn flag "name" off). Switches an indicated flag off. 

Players 
Change relations between players. (change "relations" between players). Set relations between 
players. This will not affect the behaviour of computer players, i.e. players for whom the "Give control to 
computer player" action has already been performed. To make it affect computer players, run this action 
before the AI is started. 

Computer Player 
Give control to computer player. (launch "intelligence" AI for player "name". Difficulty level: 
"difficulty". Territory type: "relief". Resources: "funds". Minerals: "resources"). This action 
launches the AI if the player defined with the "name" parameter possesses peasants. The AI is a program 
used to control units and buildings of a given colour. In order for the computer player to develop correctly, 
you should set start parameters. "Difficulty" specifies the computer player's aggressiveness. "Relief" 
tells the computer whether there is water on the map and whether it is possible to get to the enemy base 
overland or if transport is required. "Funds" specifies the initial resources the AI possesses. "Resources" 
indicates the amount of mines near its base. 
Don’t use selected units by computer player. (don’t use selected units by computer player 
"name"). If a mission creator wants to help the computer player to control the units of its colour, then, 



firstly, he must select these units with the action from the "Select Units" subgroup and perform this 
action. Also, you should indicate the colour of the computer player in the player "name" parameter. 

Select Units 
This subgroup contains actions for selecting units. With units selected, you can perform various actions. 
Some actions are to be carried out with selected units only. You can select units either by changing a 
previous selection or adding them to the previous one. If you change a previous selection, it will be lost. If 
you add units to a selection, you will retain the previous selection and have another one made at the 
same time. Remember, players select their units and give them orders during the game. A selection made 
by a player can be used by a scenario. 
Select all units of group. (select all units of group "name" by "changing/adding" previous 
selection). As a result of this action, units of a given group will be selected, regardless of which player 
they belong to. 
Select player’s group units. (select units  of player "name1" of group "name2" by 
"changing/adding" previous selection). This action affects units of a certain group that belong to a 
certain player. 
Select player’s units in zone. (select units of player "name1"  in zone "name2" by 
"changing/adding" previous selection). Selects units located within a certain area and belonging to a 
certain player. 
Select player’s units of a certain type in zone. (select "type" units of player "name1" in zone 
"name2" by "changing/adding" previous selection). Selects units of a certain type located in a 
certain zone and belonging to a certain player. 
Select units of a certain type by player. (select "type" units of player "name" by 
"changing/adding" previous selection). Selects units of a certain type belonging to a certain player. 
Deselect player units. (deselect units of player "name"). Deselects units of a given player. No unit 
of a given player will be selected after this action. 

Unit Operations 
This subgroup contains actions for creating, removing and changing characteristics of units or their 
groups. 
Change unit colour. (transfer selected units from player "name1" to player "name2"). Selected 
units of a player will change colour and be shifted to the latter player’s possession. As a result, the units 
will be deselected. 
Enable production of units/buildings. (enable production of "unit type " units for "player" 
player). A certain player will again be able to create indicated units which have previously been restricted 
with the "Disable production of units/buildings" action. In order to produce units of any nation, a 
player must possess buildings where these units are produced. 
Disable production of units/buildings. (disable production of "type " units for player "name"). 
Disables production of a certain type of units for an indicated player. 
Carry out unit building and add to dynamic group. (carry out "type" unit building in structure of 
group "name1" and add to dynamic group "name2"). In every building of group "name1", launch 
production of one unit, specified as "type". "type" is a kind of unit, e.g. the 18th c. pikeman. When built, 
units are added to the dynamic group "name2". The speed of unit production is the same as specified in 
the information window. That is why it will take some time for units to be added to a dynamic group. To 
speed up unit production, use the "Carry out fast unit building and add to dynamic group" 
command. It is undesirable for group "name1" to contain buildings which cannot produce units of the 
specified type. 
Carry out fast unit building and add to dynamic group. (carry out fast "type" unit building in 
structure of group "name1" and add to dynamic group "name2"). Launch quick production of one 
unit specified as "type" in every building within group "name1". "type" is a kind of unit, e.g. the 18th c. 
pikeman. When built, units are added to dynamic group "name2". The speed of unit production is 
considerably higher compared to that set in the information window. Unit production with normal speed is 
carried out by using the "Carry out unit building and add to dynamic group" command. It is 
undesirable for group "name1" to contain buildings which cannot produce units of the specified type. 
Create units in formation and assign to dynamic group. (create "type" units in formation 
"name1" for player "name2", place it in zone "name3" in direction "integer" and assign to 
dynamic group "name4"). For player "name2", create units specified as "type". "type" is a kind of 
unit, e.g. the 18th c. pikeman. The number of units and formations are indicated in "name1". Place units 
in zone "name3" and turn them in direction "integer". The contents of dynamic group "name4" will be 
cleared and the created units will be added to it. This action creates units, as well as ready-made 
buildings. To create a building foundation, use the "Create unit and add to dynamic group" action. A 
foundation can be constructed with the "Repair/build up group buildings with peasants selected" 
action. If this map does not contain a single unit of any nation, units of this nation are not created with 
this action. To add a nation to the map, use the map editor. Buildings are created as ready-made. 
Create unit and add to dynamic group. (create "type" unit for player "name1" in zone "name2" 
and assign to dynamic group "name3"). Creates one unit, set in "type", to belong to player 
"name1" and be located in zone "name2". Units will be added to a dynamic group. For buildings, this 



action creates a foundation which can be built with the "Repair/build up group buildings with 
peasants selected" command. Use the map editor to add a new nation to the map. Buildings are created 
as ready-made.  
Save player’s selected units to dynamic group. (save selected units of player "name1" to 
dynamic group "name2" by "changing/adding" previous units). Saves selected units of a certain 
player to an indicated dynamic group. If the action is performed by "changing", units which belonged to 
this group before the action will no longer belong to it. 
Transfer units from one dynamic group to another one. (add units of dynamic group "name1" 
to units of dynamic group "name2"). Combines units of two dynamic groups. The group created will 
be saved into the second parameter. The group indicated as a first parameter will be empty with no units 
in it. 
Kill selected units. (kill selected units of player "name"). Selected units of an indicated player die as 
if "Delete" had been pressed. 
Remove units selected. (remove selected units of player "name"). Allows you to remove units from 
the map without death animation. 

Unit Orders 
Orders are commands a player can give units during the game. Attack or patrol, for example. 
This action can be used several times. In other words, if one of the actions, i.e. "Send units selected 
into zone specified" is performed and units have not reached the specified zone yet, with the scenario 
performing this action again, then units will reach the zone of the first command and head for the zone of 
the second one. The amount of waypoints a route consists of is restricted by RAM volume. Don't set 
waypoints for officer and drummer squads created in the map editor, for if they encounter an enemy on 
their way and are engaged, the waypoints will be lost. 
Set rally point for built units. (set rally point for buildings in group "name1" into zone 
"name2"). Moves rally point for units built in buildings belonging to a given zone into the centre of a 
certain zone. 
Repair/build up group buildings with peasants selected. (repair/build up buildings of group 
"name1" with selected peasants of player "name2"). Selected players will repair/build up a building 
of a group specified. 
Attack enemy with units selected. (selected units of player "name1" attack group "name2"). 
The selected units of the player specified with the player "name1" parameter will head to attack enemy 
units of the group specified in the group "name2" parameter. 
Attack enemy in zone with group units. (units of player "name1" attack enemy in zone 
"name2" with group "name3"). Units of a group specified belonging to a specified player will attack 
the enemy in the indicated zone. 
Order selected units to go to zone saving waypoints. (order selected units of player "name1" to 
go to zone "name2" saving waypoints, place them in direction "integer"). This command will send 
selected units of a given player to the specified zone. On reaching it, they will turn around in the direction 
specified with the direction "integer" parameter. While walking, units will pay no attention to enemy 
units. Therefore, this command is useful for retreat. 
Order selected units to go to zone without saving waypoints. (order selected units of player 
"name1" to go to zone "name2" without saving waypoints, place them in direction "integer"). 
This command is similar to "Order selected units to go to zone saving waypoints", the difference 
being that units forget previous waypoints. Thus, this action will set the first waypoint. 
Order selected units to go and attack saving waypoints. (order selected units of player 
"name1" to go and attack to zone "name2" saving waypoints and place them in direction 
"integer"). This will send selected units of a given player to the specified zone and save waypoints. All 
enemy units in the field of vision are subject to attack. 
Order selected units to go and attack without saving waypoints. (order selected units of player 
"name1" to go and attack to zone "name2" without saving waypoints and place them in 
direction "integer"). Sets the starting waypoint in a specified zone for selected units of the player 
specified. Units will attack enemies on their way. On reaching the zone, the specified units will be placed 
in the direction indicated. 
Patrol the territory with units selected. (patrol territory with selected units of player "name1" 
starting from their location to zone "name2"). The location of the selected unit is the first patrol 
point. Another patrol point is located in the centre of the specified zone. While patrolling, a unit roams 
from one point to another. Having reached the second point, the unit will return to the first one. In this 
way it roams endlessly. As soon as your unit spots an enemy, it will start chasing him. Once the enemy 
has been killed, the unit will resume patrolling. 
Attack zone with artillery. (attack zone "name1" with "name2" player’s artillery from group 
"name3"). The artillery of a group specified belonging to a specified player will start shelling the zone 
indicated. 
Attack buildings in zone. (attack buildings in zone "name1" with "name2" player’s artillery 
from group "name3"). The artillery of a group specified belonging to a specified player will start shelling 
enemy buildings located in the zone indicated. 



Stand ground. (stand ground with selected units of player "name"). Selected units of a player 
specified will switch to "Stand Ground" mode. With this mode activated, the units receive defence and 
attack bonuses but will not leave their position, whatever happens. 
Cancel stand ground. (cancel stand ground for selected units of player "name"). This cancels the 
"Stand Ground" mode for the selected units of a player specified. 
Enable attack. (enable attack for selected units of player "name"). Selected units of a player 
specified are enabled to attack enemies. 
Disable attack. (disable attack for selected units of player "name"). Selected units of a player 
specified are disabled to attack enemies. 

Upgrades 
Carry out upgrade. (carry out upgrade "name1" for units of group "name2"). If you want to 
upgrade either a tower or mine, both should belong to a group specified. The group must contain only the 
building to be upgraded and should not be dynamic. A group is required for the remaining upgrades, for it 
is needed to identify which player is to obtain the upgrade. It is recommended for the group to contain 
units of that player only. 
Disable upgrade. (disable upgrade "name1" for player "name2"). A player specified won't be able 
to carry out the specified upgrade. This command doesn't affect the "Carry out upgrade" action. 

Resources 
Actions for operating resources. 
Add resource to player. (add player "name" "quantity" of "resource"). A player specified will 
receive a given amount of the resource indicated. 
Take resource from player. (take from player "name" "quantity" of "resource"). A player 
specified will be deprived of the indicated amount of the given resource. 
Set the amount of resource for player. (set player "name" "quantity" of "resource"). This will set 
a specified amount of an indicated resource for a given player. 

Objectives 
These actions control the mission objectives window. 
Hide objective. (hide objective "message"). The selected objective won't be displayed in the mission 
objectives window. 
Show objective. (show objective "message"). The selected objective will be displayed in the mission 
objectives window. 
Reflect objective as met. (reflect objective "message" as met). The text of the selected objective 
will be crossed out. 

Message Windows 
This brings up information windows. 
Show message. (show message "text"). A message consists of a picture with an explanatory text. 

Map 
These are the actions used to operate the game screen, mini-map and fog of war. 
Set screen into zone. (set screen into zone "name"). The centre of the game screen will shift 
immediately to the centre of the zone specified. 
Show alarm signal. (show alarm signal from zone "name" centre). The alarm signal will ring out 
and the mini-map will show a yellow expanding frame. The frame centre coincides with the centre of the 
zone specified. 
Open map area. (open map area "number" of radius "parameter" in zone "name"). A so-called 
fog of war removal beacon with a specific number is placed in the centre of the specified zone. The value 
of the radius "parameter" corresponds to the radius of a pikeman's field of vision. 
Close open map area. (close map area numbered "integer"). This turns off an open map area with a 
number specified. 

Resource Procurement 
These are commands that make peasants of a certain group gather a given type of resource. Peasants will 
find the nearest source of the specified resource and start gathering it. 
Order to gather food. (order peasants of group "name" to gather food in place of their 
location). 
Order to chop wood. (order peasants of group "name" to chop wood in place of their location). 
Order to quarry stone. (order peasants of group "name" to quarry stone in place of their 
location). 

Gates 
Actions for operating gates. 
Open selected gates. (open selected gates of player "name"). The selected gates of a specified 
player will open. Nothing will happen if the gate is already open. 
Close gates selected. (close selected gates of player "name"). The selected gates will close. 



Transport 
Actions for controlling ferries. The ferry must be moored. 
Embark units on ferry. (embark selected units of player "name" on selected transport). If a 
selected ferry of a player specified is moored, this action will cause the selected units to board it. The ferry 
and units must be selected at the same time. Lack of space on the ferry will cause units to remain ashore. 
Disembark one unit. (disembark one unit from selected transport of player "name"). This will 
make one unit disembark from the selected ferry of the specified player. 
Disembark all units from transport. (disembark all units from selected transport of player 
"name"). This will disembark all units from a selected transport of a player specified. 

Game End 
These are commands that bring on a victory or defeat message as soon as the game is over and the 
player exits to the main menu. 
Victory. (victory). Informs a current player that he has won. 
Defeat. (defeat). Informs a current player he has been defeated. 

Creating a scenario 
In this section, the milestones of mission creation will be highlighted. Having met all the requirements of 
this section, you will get the mission kernel you can broaden with a multitude of plotlines, depending on 
the extent of your imagination. 
Virtually, scenario creation starts in the map editor. First of all, you need to mull over the map landscape: 
the location of land and water, placing of mountains and defining passable/impassable areas. This is a 
rather important stage, for changing the landscape in later stages will be more laborious. 
When the landscape is ready, place units and buildings on the map, and then proceed with the creation of 
groups and zones. Now you can start developing your scenario. 

Mission Properties 
Mission properties include the name, description and a picture. They are the face of your mission, which 
people will recognize and a player will get his first impression by. You can change the mission description 
with the "Properties …" command in the "Scenario" menu. 
The user sees the mission name in the list of single missions when he wants to play the mission you 
created. Also, this name is used for opening the scenario in the scenario editor. By default, the name of 
the mission coincides with the name of map the scenario is built on. 
A mission description is required to give players an idea of your mission and ultimately convince them to 
get into your whirlpool of adventures. 
The picture is a visual image of your mission. There is a standard picture for mission descriptions, but it 
will hardly be able convince the player to opt for your mission. To avoid this, there is a "Load picture …" 
button. 

Names of Players 
Player names are a very important point. It would be rather odd if computer-controlled brigands were 
called by the player's colour. We recommend changing standard names for each player, as this will make 
the mission more realistic. 

Mission Completion: Victory and Defeat 
Key triggers are those containing mission completion actions. Without defining victory and defeat, the 
mission will be incomplete. 

Objectives and Messages 
Without using objectives, the player may not grasp what is required from him in the mission. The player 
needs to be informed on current objectives. This can be done by means of tasks or messages. 

Level of Difficulty 
In good missions, the complexity of the tasks as you walk through progresses in a linear way, and not in 
leaps and bounds. On an easy level of difficulty, even a newbie must be able to have fun when playing. 
There should always be enough resources, to prevent famines or to prevent the player from running out of 
gunpowder, iron or gold. The quantity of information on mission objectives and ways of accomplishing 
them should also depend on the level of difficulty. Cossacks is an economic strategy game. Don't forget 
that the quantity of resources the player gets at the beginning of the mission and on accomplishing some 
interim tasks will strongly impact the complexity of the mission. 

Relations between Players 
By manipulating this parameter you can considerably diversify your scenario. 

Allowed Types of Units and Upgrades 
If you do not wish one of the players to have a possibility to build certain units and carry out certain 
upgrades, then don't forget these parameters. 

Trial Mission 



Let's create a trial mission to try out the editor's abilities. 

Plot 
At the start of the mission, a player is given a small squad of pikemen and riflemen, located in the upper 
left corner of the map. The player leads them down the road towards the lower right corner of the map. 
The road takes the squad to a small hostile village. Having killed its defenders and captured the market, 
the player obtains a caravan that must be taken to his shipyard, located in the lower right corner of the 
map, down the same road. On his way, the player encounters a merchant who offers him money if he 
agrees to escort him to the shipyard. Going further down the road, the squad is attacked by greedy 
brigands on the lookout for prey. The mission is considered accomplished if the caravan reaches the 
shipyard. The player loses if the enemy wipes out the entire squad or caravan. 

Scenario Creation 

The following instructions show you how to create you first mission. We have already included a ready 
made version of this called "MY FIRST MISSION". You can see what it should look like by clicking on "File 
> Open" in the scenario editor and choosing "MY FIRST MISSION". Now continue to create a mission 
yourself. Let's use the ready-made "test.m3d" map. Click on "File > New" in the scenario editor. You are 
now in the Cossacks root directory. Scroll right and choose the file "TEST.M3D", then select "OPEN". A new 
scenario is created and the "Trigger" function is available. First, set the name of the mission: Scenario > 
Properties > Mission Name …. 

Scenario Properties Settings 
Select the "Properties ..." command from the "Scenario" menu. 
Name: "Test". 
Description: "This is a simple mission to demonstrate the basics of single mission creation." 
Leave the default picture. 
Click on "OK". You will return to the first menu 
Click on "File" and then "Save". The scenario is now saved and called "TEST". If you click "File > Open", 
you will see it in the list next to the ready-made "MY FIRST MISSION". (If you need help, click on "MY 
FIRST MISSION" to see what has to be done). 
 
Now continue your TEST mission … 
 
Next, you will need to create triggers. 

Triggers 
The following groups have been created in the map editor: 

- "Group0" - player's squad 
- "Group1" - village defenders 
- "Group2" - market to be captured 
- "Group3" - merchant 
- "Group4" - Johnny's gang 
- "Group5" - shipyard and adjacent structures 

List of zones: 
- "Zone0" - village defenders discover the player's squad approaching their domain 
- "Zone1" - the caravan is set up 
- "Zone2" - dialogue with merchant 
- "Zone3" - halt at the well 
- "Zone4" - shipyard 

Setting Start Parameters 

 
Create a new trigger and name it "Setting of start parameters". This is where we'll indicate initial 
resources for players, rename needed players and define relations between them. We'll also deactivate 
"Flag0" later on and rename it to "Merchant belongs to red player". The trigger should snap into action as 
soon as the mission starts, therefore we leave the condition section without changes. Add a new action: 
"Set the amount of resource for player" from the "Resources" group. When setting the "player" parameter, 
the names of players should be changed. Rename the red player to "Captain Newman", the blue one to 
"Hostile Danes", the violet player to "Civilians", and the black one to "One-eyed Joe's gang". Using this 
action and the "Duplicate" command, set 10000000 gold, food, iron and coal for the players "Captain 
Newman" and "Hostile Danes". Set the same amount of food for the "Civilians" and "One-eyed Joe's 
gang". The red player is friendly towards the civilians, i.e. the violet player. To seal their friendship, use 
the "Change relations between players" action. In the dialogue window of the player relation setting, drag 
the violet rectangle onto the same horizontal line as the red one and click "OK". Now they are friends. 

CONDITION: 

- ALWAYS 



ACTION: 

- Set player <Captain Newman> 10000000 of gold. 

- Set player <Captain Newman> 10000000 of food. 

- Set player <Captain Newman> 10000000 of iron. 

- Set player <Captain Newman> 10000000 of coal. 

- Set player <Hostile Danes> 10000000 of gold. 

- Set player <Hostile Danes> 10000000 of food. 

- Set player <Hostile Danes> 10000000 of iron. 

- Set player <Hostile Danes> 10000000 of coal. 

- Set player <Civilians> 10000000 of food. 

- Set player <One-eyed Joe's gang> 10000000 of food. 

- Change relations between players. 

Loss of Squad 
This trigger will always describe a global defeat. If the player loses all his units, he loses. The loss of 
people will mean that the number of units in the player's group is equal to zero. An action in response will 
be a message that the mission has failed and defeat is conferred upon the player. Use the picture from the 
"Austria" group numbered 44 for the message. 

CONDITION: 

- Number of units in group <Group0> equals 0. 

ACTION: 

- Show message. "You have lost all your men." 

- Defeat. 

Start Dialogue 
A new trigger will be named "Start Dialogue". This trigger will open up the basic story line and inform the 
player about his current objective. Add the "Show objective" action. Rename "Objective0" to "Wipe out 
village defenders and capture the market." Choose a picture you like henceforward. 

CONDITION: 

- ALWAYS 

ACTION: 

- Show message. "This road will lead you into an enemy village. Wipe out all its defenders and capture 
the market." 

- Show objective. "Wipe out village defenders and capture the market." 

Capturing the Market 
The player will automatically capture the market with his unit the same way as is done with civilian 
buildings in Cossacks. The condition for this event will be that the number of units from "Group2" and 
belonging to the red player must be more than 0. Then, in "Zone1", a packhorse coloured red appears. In 
the dialogue window of the dynamic group selection, select the first group named "DynGroup0" and 
rename it to "Packhorse with booty". Cross out the first objective: "Wipe out village defenders and capture 
the market". Then rename "Objective1" to "Deliver caravan to shipyard. If you lose the caravan, you will 
lose the mission!" and click "OK". The buildings located in the vicinity of the shipyard should be given to 
the player for him to be able to see his destination. 

CONDITION: 

- Number of units of player <Captain Newman> in group <Group2> is more than 0. 

ACTION: 

- Show message. "You have plundered this pitiful village." 

- Show message. "You have loaded the booty onto a packhorse. Now your objective is to deliver this 
load to the shipyard located further down the road. Losing the caravan means you lose your mission!" 

- Create packhorse units (original) in formation ALONE for player <Captain Newman>, place it in zone 
<Zone1> in direction 200 and assign to dynamic group <Packhorse_with_booty>. 

- Show objective. "Deliver the caravan to the shipyard. Losing the caravan means you lose the 
mission!" 

- Reflect objective as met. "Wipe out village defenders and capture the market." 



- Select all units of group <Group5> by changing previous selection. 

- Transfer selected units from player <Civilians> to player <Captain Newman>. (by changing unit 
colour) 

Packhorse Delivered to Shipyard 
As soon as the packhorse reaches the shipyard area, the player has won. 
The "Victory" action will stop the game and, having pressed the Escape key, the player will return to the 
main Cossacks menu. 

CONDITION: 

- Number of units of group <Packhorse_with_booty> in zone <Zone4> is more than 0. 

ACTION: 

- Show message. "You have coped with the task. Victory!!!" 

- Victory. 

Packhorse Destroyed by Enemy 
If the packhorse is lost, the player loses the mission. To enable the destruction of the packhorse, it should 
be created first. The packhorse is created as soon as the market is captured by the player. Two conditions 
will accomplish this trigger. First: the number of units in the "Packhorse with booty" group is equal to 0. 
Second: The Danes do not possess the market. Also, the trigger brings on the lost packhorse message 
and performs the "Defeat" command. 

CONDITION: 

- Number of units of player <Captain Newman> in group <Packhorse_with_booty> equals 0. 

- Number of units of player <Hostile Danes> in group <Group2> equals 0. 

ACTION: 

- Show message. "You have lost the packhorse and your mission failed." 

- Defeat. 

Dialogue with Merchant 
When the player's units encounter the merchant, the latter offers a bargain. The dialogue's condition is 
that at least one player's unit reaches the zone of the merchant's location. The bargain is in fact a 
question. This is implemented by means of the "Inserted condition block" action and the "Affirmative 
answer to question". If the player agrees to the offer, the merchant joins the player's team and a new 
objective appears in the mission objectives window. Rename "Objective2" to "Escort the merchant to the 
shipyard and he will repay you in good money. " 

CONDITION: 

- Number of units of group <Group0> in zone <Zone2> is more than 0. 

ACTION: 

- IF 

 - Affirmative answer to question. "Good day, noble sir. I see you are a courageous commander, 
but be vigilant, for One-eyed Joe's gang is rampaging in the vicinity. If you could escort me to the 
shipyard, I would pay you generously." 

  THEN (action) 

 - Show message. "Your information is worth far more than money. Follow us and fear nothing." 

 - Select all units of group <Group3> by changing previous selection. 

 - Transfer selected units from player <Civilians> to player <Captain Newman>. (change unit 
colour) 

 - Show objective. "Escort the merchant to the shipyard and he will repay you in good money." 

 - Turn flag <Flag1> off. 

  ELSE (action) 

 - Show message. "I wish you had decided otherwise. Have a safe journey then, good man." 

 - Select all units of group <Group3> by changing previous selection. 

 - Order selected units of player <Civilians> to go to zone <Zone4> without saving waypoints, 
place them in direction 40. 

Merchant has reached the Shipyard 



When the merchant reaches the shipyard area, he thanks the player, becomes a unit of violet colour and 
leaves on his own business. 

CONDITION: 

- Number of units of group <Group3> in zone <Zone4> is more than 0. 

ACTION: 

- Show message. "Thank you. I'm glad the journey proved so safe. Take this purse. Good luck, 
officer." 

- Reflect objective as met. "Escort the merchant to the shipyard and he will repay you in good money." 

- Select all units of group <Group3> by changing previous selection. 

- Transfer selected units from player <Captain Newman> to player <Civilians> (change unit colour). 

- Select all units of group <Group3> by changing previous selection. 

- Order selected units of player <Civilians> to go to zone <Zone4> without saving waypoints, place 
them in direction 40. 

Merchant's Death 
If the merchant is coloured red (i.e. a correspondent flag is activated), and gets killed, then the task to 
escort the merchant to the shipyard is no longer active. 

CONDITION: 

- Number of units in group <Group3> equals 0. 

- Flag <Flag1> is off. 

ACTION: 

- Show message. "Sir, an enemy bullet has shot our companion down." 

- Show message. "Rest in peace, your money is in good hands." 

- Hide objective. "Escort the merchant to the shipyard and he will repay you in good money. " 

Dialogue with Defenders 
This trigger initiates the first mission skirmish. The Danes were not expecting the player, and as soon as 
his squad shows up within the field of the patrol's vision, the Danes start attacking. This trigger activates 
the next Defenders' assault on player's squad trigger. 
 

CONDITION: 

- Number of units of group <Group0> in zone <Zone0> is more than 0. 

ACTION: 

- Show message. "You have intruded into our domain. You will now rejoin your ancestors!" 

- Show message. "Be silent and die in a fair combat!" 

- Turn flag <Flag0> off. 

 

Defenders Assault Player's Squad 
When the player encounters village defenders, they attack the player's squad at once. The assault is 
carried out with two actions. At first, the squad of defenders must be selected, then the player's squad is 
attacked with Danish units. 

CONDITION: 

- Flag <Flag0> is off. 

ACTION: 

- Select all units of group <Group1> by changing previous selection. 

- Selected units of player <Hostile Danes> attack group <Group0> (Attack enemy with selected 
units). 

Halt at Well 
Brigands attack the squad when it approaches the well. 

CONDITION: 

- Number of units of group <Group0> in zone <Zone3> is more than 0. 

ACTION: 

- Turn flag <Flag2> off. 



Brigands' Assault 
The brigands will attack if at least one of the red player's units shows up in the zone near the well. The 
attack is carried out the same way as in the previous trigger. 

CONDITION: 

- Flag <Flag2> is off. 

ACTION: 

- Select all units of group <Group4> by changing previous selection. 

- Selected units of player <black> attack group <Group0> (Attack enemy with selected units). 
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